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Welcome to iView MediaPro

iView MediaPro is the easiest and fastest way to view, organize and present the growing number of
photos, images, movies, sounds, fonts and other media files on your disks.
Whether you are a photographer, graphics artist, publishing professional, musician, scientist, lecturer,
student, doctor, cinematographer, multimedia programmer, web author, newspaper editor, or you
simply want to keep your family images organized, iView MediaPro will simplify your task by giving
fast access to those media files on your disks or those archived on CDROM or any other storage
device.
In brief iView MediaPro allows you to create media catalogs containing thumbnails and annotations
that can be viewed even when the original files are no longer on a mounted drive. Organizing your
media into catalogs allows you to search and retrieve media, based on annotations such as caption,
keywords or digital camera information.
You can use media in iView MediaPro catalogs to create slide show presentations, print multi-image
reports, export into one of several export options, as well as calibrate them in order to enhance their
color, brightness, or other visual characteristic.

Installation & System Requirements
To install iView MediaPro simply drag the application folder onto your hard disk. To use iView
MediaPro effectively you need to preserve the arrangements of the folders inside the iView MediaPro
folder. In particular, there must be a Plug-Ins folder that contains application files that extend its
functionality.

•  Hardware - iView MediaPro will run on all PowerPC or newer computers.
•  System Software - iView MediaPro will run on Mac OS X as well as System 8.5 or higher.

Because iView MediaPro is a carbonized application (runs natively under OS X) the
"CarbonLib" system extension needs to be installed on systems 8.5 or higher. CarbonLib
version 1.0.4 is required and can be downloaded at:
http://asu.info.apple.com/swupdates.nsf/artnum/n11673

•  QuickTime - iView MediaPro requires QuickTime 3.0 or later. We highly recommend getting
the latest version of QuickTime which is free. Download the FULL install (the basic install will
not let you view TIFF and Fax files) http://www.apple.com/quicktime/

•  Memory - iView MediaPro comes with a default setting for preferred memory of 8 MB of
RAM. iView MediaPro will typically use this memory to hold multiple open catalogs. Except in
certain cases iView MediaPro does not require more memory, as images are loaded using
available system memory.

•  Monitor - For best viewing of your images you should set your monitor color settings to
"thousands" or "millions".

•  Hard Drive Space - iView MediaPro requires a minimum of 2 MB of hard disk space to run.
However the size of the catalogs you create will largely depend on the amount of disk space
available.

Adding Media Importers
Additional media importers can be downloaded from various locations on the Internet. Any QuickTime
based media importer can be used by iView MediaPro. Simply download the importer and place it
inside your extensions folder, or inside Plug-ins:Importers folder.
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PDF and EPS - To catalog PDF and render EPS files you need to download Aladdin Ghostscript
System extension, that can be downloaded at: ftp://ftp.cs.wisc.edu/pub/ghost/aladdin/gs600/mac/test/
DICOM and X-Rays – To catalog and render scitex CT and DICOM medical files you need to
download the QuickTime Importers by Escape (http://www.escape.gr/dicom/).

AppleScript
iView MediaPro is scriptable. As such it can be easily integrated with 3rd party applications or data
base system to provide a full solution to a workflow automated system. To get started with scripting
iView MediaPro, have a look at the application's dictionary, and refer to the Apple Script related
documentation and samples included in this installation.

Languages
At this time, iView MediaPro has modules that allow it to be viewed in: US English; Spanish; French;
German. iView MediaPro will soon also be available in Japanese and Italian.
The language choice can be changed at any time by selecting from the Language drop-down menu in
the application's Apple menu. By default, iView MediaPro automatically uses the language of the
operating system or remembers the last language used.

Using iView MediaPro
When you add your media files in an iView MediaPro catalog, the application stores a small thumbnail
of each file, as well as, information about the file and its location on your disk. Your original media
files are needed in order to display them in full, in the application's media view. You can launch and
search iView MediaPro catalogs, even when your original files are not present. For example, they may
be stored in a CDROM that is not mounted.
It is important to note, however, that iView MediaPro catalogs do not include the original media file.
Deleted media files cannot be recovered using iView media catalogs. It is also worth noting that during
import into a catalog, iView MediaPro does not move or modify the original media files.
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Creating Media Catalogs

To open the application, double-click the iView MediaPro icon.
Drag any file, folder, hard disk, CDROM, or other volume into the iView MediaPro window. You can
also drop the files onto the iView MediaPro icon. In either case, your media files appear in an iView
MediaPro catalog.
You can organize your catalogs of particular disks or according to your own categories of images,
sounds, movies, etc.

An iView MediaPro catalog contains:
•  A thumbnail  of each media file.
•  Media information  about each media file pertaining to the media type (image, animation,

sound, digital camera information, postscript, etc.).
•  The location (path or alias) of the original file on hard disk, CDROM, or other volume,

including a reference to an internet site if the image originated there.
•  Annotations that exist in the original file or that you add later.
•  A digital voice recording that exist in the original file or that you add later.

It is easy to add new media files to an existing catalog. Simply drop the folder that contains the new
files onto the catalog. iView MediaPro will go through the contents and append only the new files to
the catalog. You can also add items by dropping images from Internet browsers.

Scroll Lock - This icon appears on top of the scroll bar in all views. It locks/unlocks list scrolling while
importing images. This is useful when you want to examine in detail an image during import. Say for
example that you want to view images as they are dropped and you see one that you want to examine
before importing is done. You can lock the list scroll and switch to image view, letting iView MediaPro
carry on with the importing.
Tabs Opener – This icon will show/hide the tabs and toolbar giving you more viewing space in your
catalog window.
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Controlling The Import Process
You can control the import process by choosing Edit | Import Options
Import options have a direct influence on what media files are inserted in a catalog, as well as hw fast
they are inserted.

The Search panel allows you to limit the range of imported media based on file related criteria, such as
file name, file size, creation or modification date, etc. For example, in order to import files smaller than
1 MB you may choose to enable the size option as:
size is less than 1000 KB

The “Media Types” panel allows you to limit importing to just those files that belong into a certain
media group. For example you may switch on the Images option only in order to import images such as
JPEG, Pictures, etc. If you are not familiar with what types of media files belong to each group you
may click the View Media Formats button, for a comprehensive list of all types supported by iView
MediaPro. Please note that this list may grow as newer importers are added to the application or to your
QuickTime installation. All importers are enabled by default except text/HTML based files.

Finally, the 3rd panel “On Import” will let you adjust the importing process. This panel includes the
following options:

•  Ignore built-in thumbnails  will greatly improve importing speed, as iView MediaPro needs to
render the entire image in order to create it's own thumbnail. However, note that thumbnails
created by 3rd party applications or digital cameras may be of much lower quality. It is
recommended to leave this option on, and later choose to re-build a catalog's thumbnails using
Action | Rebuild Preview.

•  JPEG Compress thumbnails will, in general, reduce the size of your catalog by a magnitude
of 5. It s recommended that you switch this option on if you are planning to have large catalogs
(over 1000 items), as the size of a catalog with uncompressed thumbnails may run to 10 MB+.
The downside of this option is that display speed (especially in the thumbnail view will drop
considerably).

•  Match sample colors to palette lets you limit the colors used by iView MediaPro in order to
create the sample color for each imported item.
The sample color is a field that can later help you choose images based on color similarity.
iView MediaPro uses color palettes created by Adobe Photoshop that can be placed in Plug-ins |
Color Tables folder. In order to create the sample color iView MediaPro picks the most
frequently used color in the item's thumbnail. You can later select a specific color via Action |
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Reset Sample Color, that uses Apple's color picker. whichever way, iView MediaPro will
normalize the color to the selected color table.

•  Color used for transparencies lets you define a color that will be used by iView MediaPro for
painting transparent parts of an image. This is useful on certain media types that support
transparency.

Understanding The Import Process
iView MediaPro goes through a number of steps in order to extract media info, create the media
thumbnail and scan for annotations. In brief the import sequence has as follows:
Extract media attributes (size, resolution, duration, etc.).
Create thumbnail, and optionally sharpen and compress.
Scan for specific information pertaining to the media type. For example if a JPEG image is being
imported, iView MediaPro will scan the images information tags in order to extract: JFIF Comments,
Adobe Image Resource Block, ColorSync profile, IPTC annotations, EXIF digital camera data,
embedded voice annotations.
If no annotation has been imported, scan the file's resource fork for the 'ANPA' or 'FETCH' related
resources.
Extract Finder comments and detect optional URL address.
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Viewing Files in Your Catalogs

The iView MediaPro window displays information in one of three views. To switch between views,
click the appropriate tab, or press Command 1, 2 or 3.

All 3 views offer features that resemble the way you work with your files in the Finder.
•  To find an item, type the first few letters of its name.
•  To change a file name, click the name, wait a moment, and then start typing.
•  To see a contextual menu, Control-Click an item (or anywhere inside the iView MediaPro

window).
•  To rearrange items, drag them to where you want them and drop them. You can drag single

items or groups of items.
•  To move one or more items from one catalog to another, drag them to the other catalog.
•  To duplicate items to another catalog, hold down the Option key while you drag from one

catalog to another.
•  To move or copy items from the catalog to the Finder, drag them to a folder or to the desktop.
•  To move items to another drag-and-drop application such as Adobe Photoshop or Macromedia

Director, drag them to the application.
•  To create an alias, hold down Option-Command while you drag an item to a folder or to the

desktop.

Content View
Content view the catalog as a list of file names with associated information fields such as size, type,
creation date, and so on.
To sort the list according to a field, click the corresponding header above the list area. Notice that some
information appears only for some of the media files. For example, the “duration” field applies only to
movies and sounds.
To rename a file simply click on its name and start typing, in the same way as you would do on the
finder. iView MediaPro will rename the catalog entry and the original file only if the item exists and it
is mounted on a rewritable storage disk.
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As with all views, you can adjust the look, information and size of the displayed items using the
options in the Layout dialog.

Thumbnail View
Thumbnail view displays the catalog as a table of thumbnails in adjustable sizes. When you select an
item in the table, the header (text area above the pictures) presents information about the item.

Whether the file is mounted  or not , the pathname for the location of the file referenced, and a
media related description, including format, dimensions and duration.

To change the positions of items in the catalog, click one or select a group and drag them where to the
desired location. Alternatively, after you made your selection, you can choose any of the “move to”
options in the toolbar. If you choose the “move to location” option you will need to click on a
destination item, where the selected items are going to move to.

To rename a file, click the name, wait a moment, and then type the new name.
To update the thumbnail of a media file that has been modified since it was catalogued, select the item
and choose Rebuild Preview from the Action menu.
If a thumbnail of an animation file is black or not what you want, select the item and switch to the
Media View. Play the animation to a frame you like, then choose Rebuild Preview from the Action
menu. When you return to Thumbnail view, the thumbnail is updated.

Thumbnail Size
To define the import, display and print size of your thumbnails, choose the size you want from the Size
menu in the lower left corner of the Thumbnail window. This setting affect the overall size of your
catalog as larger thumbnails require more disk space.
If an imported image appears much smaller than the thumbnail box containing it, iView MediaPro has
read an existing thumbnail rather than create its own. If you want iView MediaPro to create its own
thumbnails every time, make sure "Ignore built-in thumbnails" is selected in the Import Options dialog
in the Edit Menu.
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Media View
Media displays media files at full size, one at a time. In addition, you can play animations, movies, and
sounds, or navigate inside a virtual reality landscape scene. Finally you can flip through the pages of a
Fax, PDF or HTML document, or view the various layer of a Photoshop document using the “Pager”
floating window that appears automatically when your media item has multiple pages.

When an image is clipped and doesn't fit entirely inside the window, the cursor changes to a hand (the
"grabber"). Use it to drag the image and change your view within the window.
To zoom in, press Command+. To zoom out, press Command-
To define the way media is displayed, choose an option from the drop-down menu in the lower left
corner of the Media window.
The size and layout options of this view apply when you choose to print this view. For instance if you
want to print an image using the proper scaling, select the scaling in this view and then choose print. I
addition to print a particular layer or page within a composite file, go to the page or layer you wish
print and select Rebuild Preview from the Action Menu before printing. iView MediaPro only prints
the frame assigned as an item's preview.

Playback
As in all views, you can playback any sequence of movies and sound files, including MP3, by selecting
one or more files, and pressing the spacebar, or selecting Play in the Playback drop-down menu in the
toolbar.
To stop the playback, press the spacebar or click Stop in the Playback icon in the toolbar. To resume
the playback, press the spacebar or click Play again in the Playback button. For access to QuickTime
movie controls, play the file in the Media View.
You can also playback a selection or, playback individual files, a selection, or the entire catalog
repeatedly in a loop.
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User Definable Views/Layouts
You can customize and view by selecting which fields to include, as well as font style, text size, text
and background color. View options apply to most export functions and printing.

To add or remove a field to a view, click on its name in the field list area. You can change the size (or
number of lines) and the font style for each individual field, by clicking the double arrow icon on any
active field.

Note that you can insert a special field "Attachments" in any view. This field, unlike all other fields,
does not display text. Instead you will get one of the following small icons to indicate that the file
contains:

editable annotations

media information, such as EXIF, Postscript, Tracks, Fonts etc.

voice recording

URL reference
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Info Panel

To view the media information or editable annotations, captions, keywords or categories of a selected
item you need to reveal the Info Panel, by clicking the double arrow icon at the bottom left hand corner
of the screen, or by choosing "Show Info Panel" from the Window menu.

The Info panel contains a small con of the selected item, its name and URL as well as details about the
person who last edited the item’s annotations.
URL
When a file has been downloaded from the Internet, iView automatically assigns the Internet address
(URL), at the top of the Info Panel, next to the file preview below the filename. The address can be
modified from the "Assign/Modify URL" in the Action Menu.
To download the original media file, click directly on the address in the Info Panel, or the "Download
Original" in the Action Menu.
Editor
If you click on <Editor> at the bottom of the panel, you can add or change the name of the person who
edited the panels and, automatically assign the time and date of modifications.  
Annotating Your Media

The data inside the Info Panel is split into panes. Choose one of the panes from the drop-down menu,
or press the tab/shift tab key. The Info Panel can be resized by dragging the right hand side of the panel
to the required size.

Media Info  – displays non-editable media related data.
Version Control – displays a list of all backed up version of the selected item.
Annotation Panes (Annotations, caption, keywords and categories) – display editable fields.

All editable panels work largely in the same way allowing fast "in-line" editing of annotations, user
definable fields, captions, keywords, and categories.
To add or edit a field, simply Double-Click on the edit box next to the field label.
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By default, the favorites auto completion feature adds, any text typed into the edit box of editable
fields, to the current selected set of favorites. To disable this feature, press the field label of individual
fields to reveal the options associated with that particular field.
When you type in the edit box, with each unique letter or set of letters, the auto-completion feature
reveals the nearest word listed in the list of favorites. When you move from the field, without adding a
space (to remove the prompt), or editing the word, iView registers the prompted word with the file and
automatically adds the new unique word to the list of favorites.
Alternatively, you can browse through the list of favorites, from the drop down menu which becomes
visible when the edit field is active. To add a word to the selected field, simply scroll through the
dropdown menu and, select a word by letting go of the mouse. Notice also that when you type a letter
in the edit box, the dropdown menu displays the list at that point of the alphabet.
For quick editing, use Tab/Shift Tab key to switch to a different information panel, or use the
Command + arrow keys to switch to the same field for the next/previous media item.

  

The three icons at the top of the editable panes allow you to:
•  To save modifications permanently. This option is always applied when selecting a different

media item or when you close the catalog.
•  To discard modifications.
•  To paste a selected field, panel or full set of annotations to all currently selected items (batch).

It is important to note that editing applies to the first selected item only. To paste the contents of
the select item to more items, you need to select them by, clicking on the items pressing the
Shift or Command keys, or using shift arrow keys.

Media Annotations
iView MediaPro supports a set of "pre-defined" fields for annotating your media files. This set (also
known as "IPTC" fields), includes entries for caption, keywords, categories, etc. iView MediaPro also
supports QuickTime and Finder information that is mapped to IPTC equivalents. Editing annotations in
an iView MediaPro catalog does not affect the original files, unless you choose to synchronize the
catalog entries with the original items.
iView MediaPro also supports user fields. To add (maximum 16) or remove user fields choose "Define
fields" in the Edit Menu. You can also change the user field name, or disable the favorites auto
completion feature, by clicking on the Field label to activate the field options dialog.
It is important to note that when you move media items between catalogs, user fields are automatically
adjusted between the catalogs.

Favorites
Favorites can be grouped into different sets of favorites, definable by the users, with vocabulary
specific to different projects, languages or catalogs. By default, iView MediaPro provides a set of
favorites (a default folder with default text files), but these lists can be added, edited or replaced by
other lists, editable outside the application, using any text editor.
To edit or replace these files, simply locate the individual files inside the iView MediaPro "Favorites"
folder within "Plug-Ins". To add a new favorites set, simply create a folder within this directory.
To change the favorite set in the active catalog, select the folder in the "Favorites Sets" dialog, from the
"Define fields" dropdown menu in the Edit Menu in the application. If you select "Set as Default",
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iView MediaPro assigns the selected folder as default to new catalogs, otherwise the favorites selection
is only applied and saved with the catalog rather than the program.
When you switch from one language to another, iView recognizes the change, and creates different
default files for each language. These files adopt the localized fieldnames for easy identification, and
are located in the default favorites' folder. Again, these files can be edited or replaced by more
meaningful lists of favorites.
If you wish to preserve the favorites list, allowing users to access to the favorites list whilst restricting
any new additions, you can lock the individual favorites files in the Finder, outside the application.
Select the file, and in the Finder, go to the "Get Info" dialog in File Menu, and enable the "Locked"
option in the "General Information" panel.

Batch Edit
The principal difference between iView MediaPro and earlier versions of iView is that it has been
completely reprogrammed to fully integrate batch capabilities with the core features of the application.
Although these are subtle differences for the novice, they allow greater flexibility and are fundamental
advantages for the professional or advance user.
As far as practical, all functions can be equally applied to individual as well as multiple batch files.
Begin by making your selection. There are two standard ways to select a group, or batch, of files:
Select the first item and, holding down the Shift key, select the last item from your selection. This
selects a block of items which can be used as your group of files.
Select individual files, holding down the Apple key, while making your selection. This method allows
you to create a non-continuous selection in different areas of the catalog.
Block selection of disjointed cells. For example, to select 1-10 & 20-30. Click 1, shift click 10,
command click 20, shift click 30.
Expand current selection by simultaneously pressing the "Shift" and one of the arrow keys.
Once you have made your selection, you can virtually batch any operation, by simply selecting and
applying the feature to the selection.
There are a number of ways to batch annotations.
Annotating from the Info Panel is largely the same whether you are annotating one or more files.
Begin by either adding an annotation (caption, keyword or category) or selecting the annotation file and
record you wish to copy. Select the media items you want to include in your batch, and use the drop
down menu from the "Paste" icon in the top right hand corner of the panel. There are three possible
options, either batch the individual field, the entire panel or the entire annotation set to the selected
items.
You can also batch annotations from the Batch functions in the Annotations submenu (Action Menu).
This method of batching annotations has the advantage of allowing users to paste under specified
criteria.

Select the annotation field from the drop-down menu and, either enter the annotation text directly in the
text box or, use the favorites list from the drop-down menu. When you type in the text box, the auto
completion feature will help when you type. Start typing, if the word is in the favorites list, it will
complete it for you if the word is unique. Notice that in the drop-down favorites menu, the list will go
to the word you started to type. i.e. if the word you are looking for is "trees" and you type "t", the pop-
up menu will automatically go to the words beginning in "t"s.
Batch mode allows the user to modify field or append to the list of keywords or categories, or replace
the field according to a user defined criteria. There are two batch criteria:
Modify/Append/Clear field - this mode simply changes the field with the new text addition.
Replace if original - replaces the original file according to a specified criteria.
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Batch Remove
Clear... (Annotation in the Action Menu)
Removes the annotation fields from selected media files. "Choose" reveals the annotation fields
attached to the file or files, allowing you to select the particular field to remove. To add, modify or
remove a particular keyword, category or field, use the Batch function in the Annotations submenu in
the Action Menu.

Voice Annotation
Voice Annotations are short audio clippings embedded in any media files. These are short, memo-like
annotations, more frequently found in digital cameras or other image capturing devices which
incorporate this feature.
To listen or remove audio annotations, simply select these features from the Voice Annotation button
on the tools bar.
The button, with its full-down menu, also allows you to record your own annotation or embed a
separate sound file with the import option.
To export or extract voice annotations as separate files, select this feature from the Annotations
submenu in the Actions Menu.
Voice annotations can also be used in slideshow presentations. By default this feature is disabled.
Extract Voice (Annotation in the Action Menu)
This feature saves embedded voice or audio annotations as separate files. Some digital cameras or other
image capturing devices allow you to save voice comments with a picture, or you can simply import or
record your own voice annotation from within iView, using the Voice Annotation drop-down menu
icon on the tools bar.
You can listen or remove annotations from the same icon, or enable them in slide show presentations.

Synchronize Annotation
This command allows you to import or export annotation fields from the catalog into the original files.
This is particularly useful, as iView allows you to view, classify and batch a large number of files and
then export the changes to their original file, saving hours of time opening and editing individual files.
This feature supporting the following formats:
Import
IPTC & QuickTime Annotations
Voice recording
URL Address
Meta data (EXIF, PostScript, etc)
Export
QuickTime fields
IPTC fields
IPTC fields Cross-Platform (JPEG, Photoshop)
Fetch fields (Caption, Keywords) 
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Search And Organizing Features

iView MediaPro offers a number of ways to search and find particular media files, as well as related
file, media and annotation attributes, in and across catalogs.

Catalog Index
The single most useful search tool is the Catalog Index window in the Windows menu, which allows
users to instantly view and search the entire contents of a catalog according to a given criteria or
classification. Review and display files by any file, annotation or media field including, amongst
others, keywords, categories, user fields, sample colors.
Simply select the field and double click one or more folders to display the media files. Use "Show All"
from the Find Menu to return to the full catalog.

You can also view files by path, allowing you to locate original files, whether in the Finder, Network or
in an unmounted volume on the Internet or a CDROM.

To classify data by logical and hierarchical criteria, use the Catalog Sets to organize files under any
number of different themes, subjects, projects, products etc.

Using the Find Command
Finding by attributes
The Find feature in the Find menu includes the following options:
Find files by a number of file, media or annotation attributes.
Boolean searches for "and" / "or" searches.
Find inside the active or front catalog, across catalogs, as well as in all recent or selected catalogs, with
the option to display results in a new catalog.
Save searches as queries for frequent or common searches.
Finding Original Files
Show Duplicates (Find Menu) searches and compares similar or duplicate files, allowing you to set the
level of similarity, for example tight or loose comparisons, as well as files with similar names. This is
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particular useful for imports of images from digital cameras that use repeated filenames which can
conflict with an earlier import. This feature allows you to identify and compare two images, side by
side, and rename or discard the files.
Show Original (Toolbar) reveals the location of the selected media item or items in the Finder.
Find Missing Items (Find Menu) searches to find broken links to media files and highlights all
unmounted or missing items in the front catalog. The user to either remove the item from the list or
search for the missing file in a specified directory.
iView MediaPro keeps the path or address of the original file and can detect if the file has moved in a
relative path. If the filename has changed, the file or folder has moved, or the file, folder or volume is
no longer mounted or online, the full size image in Media view will no longer be available and an error
message (File Missing -43) appears in the top right hand corner status bar. The thumbnail and
annotation data is kept in the catalog but the path to the full size image, movie, or sound is no longer
correct. To rectify this, iView automatically launches the Reset Path dialog to amend the file paths.
Reset Path allows you to reassign or modify the path, for one or more items. This feature is useful
when you know you have repositioned a folder with items referenced in the catalog.

Organizing Original Files
With its fully integrated and enhanced batch features, iView MediaPro offers the tools to search,
monitor and organize original files dispersed in different hard discs, volumes, CDs or the Internet. As
well as offering a number of classification and organizational features to use within the application,
iView MediaPro aims at simplifying a number of lengthy and tedious routine operations outside the
application.
Rename... This command renames all selected catalog items, as well as, the original files on your
disks. This operation is irreversible. If a single file is selected, this command simply activates the
filename cell in the active view mode, as if you where clicking on the file's name. When multiple files
are selected, the command opens a "batch rename" dialog, to allow you specify a numbering sequence
for renaming your files. For example, Photo 1, Photo 2, etc. Together with the "Show Duplicates"
feature, this is particular useful feature, for imports of images from digital cameras which often use
repeated filenames which can conflict with earlier imported images.
Use this command to add or remove PC extensions. Begin by selecting files of a particular type. In the
'Add String' panel, add the file extension in the text box and chose the Trailing option. To remove
extensions, go the Convert panel.
Finder Properties
The commands under this submenu offer a number of features, allowing the user to improve the
classification and search for files dispersed on different volumes and directories, as well as the
accessibility or visibility of files by other users in the Finder.
Lock/Unlock The lock feature is useful to protect and prevent other users from modifying, renaming or
deleting original files, either with another application or within iView MediaPro.
Hide/Show feature is used to conceal or reveal original files in the Finder.
Desktop icons For easy identification of files within the application or in the Finder, replace generic
desktop icons with image icons of original files.
Finder Comments saves media caption field and URL in the comment box of referenced files, visible
in the Finder and the "Get Info" window of original files (Apple Menu)
Media Thumbnails Exports and embeds a small thumbnail into original referenced files outside the
catalog. The preview can be read by a number of media editing applications which use built-in
thumbnails in their opening dialog for quick identification.
Drop Folder
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The Drop Folder is useful for dragging and dropping media files from different directories, volumes or
locations. For example, iView can used as a palette along side other application to temporarily or
permanent store image, text, movie or sound clips, dropped from any application that supports drag &
drop, or for quick downloads from Internet browsers. The selection is saved with the catalog, so that
you can assign a different drop folder to various catalogs.
The Folder Watching option scans the selected folder for new media files while the catalog is open, or
advises when the catalog is reopened, that a new file has been added to the folder. This is particularly
useful in workgroups to monitor particular directories for new files.
Version Control
Version control is useful both for individuals and small work groups to browse and track through
different versions of the same files. This is particularly useful as a back up but also to revert to different
versions. (See section on Calibration and Version Control).

Media Labeling & Color Samples
Color labels – Labels provide a visual identification and classification of media files, and as an initial
step before more complex operations.
Labels are also useful as a means of permanent selection. After you label your item, you can quickly
select them or show them using the index floating window.
Use the Command or Shift to select several files at a time.
To add a label to the selected file or files, simply choose a color label from the drop-down menu in the
toolbar.
The "Define Labels" dialog in the Edit Menu allows the user to assign a name to the label. By default
iView automatically uses the "IPTC" Urgency labels, so that when Photoshop files are imported, the
application automatically assigns the color labels to the files. The labels can also be customized or
changed to "Finder Labels". If you save the modified setting as default, iView uses this setting in all
new catalogs. If you change the settings without saving as default, the application remembers and
applies the last setting used with that particular catalog.

Color Samples - iView MediaPro offers the ability to identify media (images, movies, etc) by a single
color, called "Color Sample". The color sample is particularly useful when searching for images of a
specific color or tonality.
A Color Sample is automatically generated when the media is imported.
For a more accurate sample color the user can choose "Reset Color Sample" option in the "Action"
menu to modify the sample color of one or more selected media files. To select a specific color from
the image or elsewhere on the screen, hold down the Option key and click on the color you wish to use
as your sample color. The color sample dialog will match the color to the closest color in the particular
color picker selected.
By default, the sample color is based on the dominant color of the image.
iView MediaPro offers the ability to restrict the range of sample colors used, by conforming the
selected (or generated) sample color to a specified color table. For example all sample colors could be
mapped to 32 basic colors or 200 predefined tones of a single color.
The sample color range can be set via the "Import Option/On Import" dialog.
iView MediaPro offers a small number of "build-in" tables. The user can define personalized tables, as
individual files, and save them in the Color Tables in the Plug-ins folder.
Color table files contain row color values of red-green-blue. Color tables can contain up to 256 colors.
Color samples can be viewed and modified in the Catalog Sets window.
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Hierarchical Sets
Hierarchical sets offer instant organization of your media, which can be applied for quick access in
slideshow presentations, quick searches or classifications, printing, Web pages - in fact any export
functions etc.
An item can belong to more than one set simultaneously, allowing catalogs can be logically organized
into sets for different projects, clients or themes, without confusing the overall annotation or
classification of files in the catalog.

You can create sets out of keywords, categories, paths, or user defined sets. These can be shifted
around to change the level or relative position of an individual set within the group of sets, or create
any number of hierarchical sets or subsets to organize your work according to a particular criteria.
To view the sets designated to a file, go to the Media Info section of the Info Panel . Where the sets
exist, the "In Sets" drop-down item reveals a list of all the sets for the particular file.
To add or view sets, select "Show Catalog Sets" from the window's menu.
Create a set by pressing the "+" button in the bottom left hand corner of the window. To add items to
the set, simply drag and drop one or more files from the catalog window to the set.
The "-" button works in the same way as the delete key, removing the selected set.

The drop-down menu of the folder icon, at the bottom left hand corner, also offers a few extra features:
Show Entries - displays the items of the selected set or group of sets, hiding all other files. This feature
works in the same way as double clicking on an individual set.
You can select a group of sets to use with this function, in one of two ways:
Select the first item and, holding down the Shift key, select the last item from your selection. This
selects a block of items which can be used with the "Show Entries" feature.
or
Select the individual sets, holding down the Apple key, while making your selection.
"Show All" function in the Find Menu, reverses this feature, revealing all hidden files.
Select Entries - selects the items of a set or group of sets within the catalog window.
Add to Set... allows you to add one or more items to a set or group of sets. Select the set(s) and item(s)
to activate this function.
Remove from Set... in the same way as the above feature, to remove an item from a set, you must
select the set or group of sets from which you wish to remove the item and, then select the item or
items to remove. This feature automatically asks you whether you want to update the group of sets to
reflect the change.
Empty Set... removes all items within a set or group of sets
Update Set... If you have recently added or removed items from the catalog, or changed field items,
this feature updates your group of sets to reflect the change.
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Note that sets do not automatically launch an update when folders, authors, keywords, or categories are
added or removed from the catalog, because sets represent logical rather than actual structure.
The add feature from fields or folder (see below) are used only to initially organize files. If, on the
other hand, you need the data to be always accurate and up-to-date, please ensure to use the "Update
Set" feature, or use the Quick Find dialog for searching and displaying files by a particular criteria.
Import from File... imports a list from any text editor to use as your group of sets. This is particularly
useful if you want to maintain consistency in your classification between catalogs or within a work
group.
Export to File ... in the same way, you can export the set list to use in another catalog, or with another
application.
Add Sets from Fields... creates sets from fields within the catalog, such as, folder names or paths,
categories, keywords and author, automatically classifying items in their respective sets.
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Slide Show Presentation

iView mepiaPro allows you to build up a slide show presentation with your images, animations and
audio soundtracks.
iView MediaPro slide shows allow you to run a single (background) sound channel as well as 1 or
more (16 max) video channels, arranged in full screen, quarter screen or a variety of other grid
arrangements.
Sound items included in a catalog are queued into the sound channel. All other media types (including
images, movies or movies with sound) are played in one or more video channels depending on your
grid selection. iView MediaPro offers several options to adjust or hold durations for individual media
items (see timings).
Please note that unless you are using a fast computer, using the slide show with more than one video
tracks will place considerable strain on your machine and degrade playback. Experiment with 2 to 4
tracks first before choosing the more complex grids.
Also note that unless you are using two monitors, displaying the control panel on top of the slide show
stage may also degrade performance.

Click the Slide Show button in the toolbar or hit Command R to start.
During the slide show, use the escape key or double click the mouse to exit.
The slide show is controlled via the floating controller, which you can display or hide by pressing the
tab key or the enter key.

The Controller allows you to adjust the presentation options; add, remove or modify the order of your
files; as well as select and present a particular file, or set of files, while running the slide show. This is
useful when you want to run live presentations on a second screen or projector, or use the captions
panel as a prompt in seminars, talks or any type of presentation.

Slide Show Options
The setup features and options can be set prior to running the slide show in front of an audience, using
the "Setup Slide Show" dialog in the Make Menu. Both methods allow you to set the following options:
Interactive (or click mode), allows the user to click the mouse or use the space bar or arrow keys to
flip to the next media item in the slide show. In this mode the pause button changes to a mouse icon.
Switch this option off to run the slide show using timers.
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Default Duration is the flip speed in seconds for each slide. (In the Controller, the duration can be
adjusted using the up and down arrows on the top right hand corner of the window) The default
duration applies only when the slide show is run in non-interactive mode. Note that movies and sounds
default to their own duration. The default duration can also be over-ridden by timings set for individual
media items (see "Timings").
Default Transition The current version of iView MediaPro offers a basic set of QuickTime™ effects
which can be used during slide show media transitions. The duration of the transition effects (1
seconds) is currently fixed. This setting will effect all media items, unless individually defined (see
"Timings").
Media Scaling lets you control the scaling of media items. You can set this option before or at any
time during running the slide show.
Continuous mode runs slide show presentations continuously in a loop, restarting automatically from
the beginning of the catalog when the slide show has finished. This mode is useful for kiosk or
exhibition presentations.
Multi-sound plays all the current sound tracks simultaneously. This option is useful only when you
intent to play multiple movies in a grid arrangement. If this feature is disabled, iView MediaPro plays
only the background sound (sound channel) as well as the last loaded movie soundtrack.
Voice Annotation will play an attached voice annotation whenever a media item is loaded.
Fade In/Out - fade the start and end of the slide show.
Layout. allows the user to define the field captions used in the slide show presentation, as well as the
background and text colors and fonts.
Timings. The generic settings predefined in the General panel can be over-ridden by defining
individual flip speeds and transition effects for particular files. The list area shows a preview of your
images in the list. Simply select a file and click on the Setup button to reveal the individual timing and
transition options.
For sound files (sound track), you have 2 options: (a) play until next sound in channel, will play the
sound to completion or until another sound is loaded, in which case the current sound is terminated; (b)
hold slide show until sound finishes, will always play the sound to completion, if there is another sound
following, the slide show will be held until the sound finishes. this option lets you define an additional
"silence" period, before playing the following sound.
For video files (images, movies, etc.) you have 3 options: (a) Default - applies the default duration
predefined for the entire slide show to both movies and images; (b) hold slide show until the sound
finishes is useful when you want a media item to play for as long as there is an audio file playing in the
sound channel. for example you may want to make sure that a certain number of images display during
a given sound. you will set the duration of the last of those images to hold until the sound finishes.
After the sound finishes the slide show loads the next image; (c) use media duration forces the native
duration of the media (o in the case of still images). This option will let you hold the duration for an
additional time of up to 99 seconds.
Video files can also be assigned individual transition effects.
Sets (controller window) let you choose to present a particular set or group of files from the file drop
down menu.
Grids The slideshow can run the standard full screen or you can divide the screen into several video
channels, from half, quarter, sixteenth, to a range of different cell arrangements.
Captions (controller) The caption area in the Controller panel displays a caption you may wish to add
to a particular image, to help you with your presentation. This is useful as a text prompt in seminars,
talks or presentations.
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TIP 1: If you use multiple monitors, position your catalog inside the monitor you want to use for the
slide show. You can start the presentation on your second monitor, and keep the control panel on your
first to steer the animation.
TIP 2: When you pause the slide show, you can inspect your images with zoom in and out (using
Command+ and Command-).

Run as a Standalone Slide Show
A particular catalog can be set to run as a standalone slide show, using the option in the Catalog Info
Dialog in the File Menu. A catalog will open as a slide show when you double click its icon in the
Finder. To reset this option and to make changes to the catalog, you will need to open it using the Open
option in the File Menu.
Prior to setting this mode, you can customize layouts and fields that are visible during the slide show,
and optionally set a password for opening the catalog. You can record the catalog and all referring
media files on a CDROM for royalty free distribution. Note that you will need to include a copy of the
iView MediaPro application (and optionally a copy of CarbonLib extension) in your CDROM. Your
recipient will be able to run your catalog from the CDROM with no need to license the software.

Save Slide Show as a QuickTime Movie Presentation
iView MediaPro lets you save the slide show (full screen mode only) as a QuickTime movie. Doing so
you can distribute your movie file without the need to include the application itself (see Movie
Presentation).
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Exporting Functions

iView MediaPro will help you export and convert your media files in a variety of ways, by selecting
options from the “Make” menu. Most of these options have AppleScript counterparts, that allow you to
perform the same function via a script.

HTML Gallery
Output a catalog as a HTML formatted web site that includes both an index page and a linked media
page for every item in the catalog.
Photographers can use this option to automatically create a web site of all their work.
An HTML Gallery looks very much like a catalog in iView MediaPro. It contains an index of
thumbnails which when clicked inside your browser will take you to a large view of the image.
QuickTime movies can also be exported along with images.
iView MediaPro offers you two options when you create HTML galleries:
1. You can use default settings to create your website based on the style and information included in
the Content, Thumbnail and Media views, and later on adjust the HTML created using a third party
HTML editor application.
2. Alternatively, you may use your own predefined templates which can be created before exporting
and saved inside the Plug-Ins | HTML templates. iView MediaPro uses a different template for the
index and media views of your gallery, and offers a rich vocabulary that can be used to extract catalog
information (fields, thumbnails, etc.), as well as a few high level tags for navigation, date, time, etc. To
create an iView MediaPro template, refer to "HTML Templates" documents included in your
installation.
NOTE: To reduce loading of your pages do not try to include more than 40 images within a single
index page. In addition you may want to choose creating low resolution images.
For regular uses of this feature, you can save your options using the Options menu. Saved options can
be recalled at any time and can be incorporated in AppleScripts.  

Text Data Table
The text data table allows you to save media properties and annotation fields in text files and import
them in third party database or spreadsheet applications. You can save text as a tab or comma delimited
text.
You can also export your data using the "merge" option, in order to create personalized documents like
form letters. For example Microsoft Word, you can combine variable data (like media names, or
properties) in a merge files with text in a main document. The merge option is particularly useful when
importing information in FileMaker Pro since it auto-detects fields to place imported data.
For regular uses of this feature, you can save your options using the Options menu. Saved options can
be recalled at any time and can be incorporated in AppleScripts.

Contact Sheet
Creates a contact sheet of all visible thumbnails of your catalog. You can adjust the size, resolution and
format of the file to be created.
iView MediaPro automatically calculates the number of cells that can fit in the designated contact sheet
size, taking into account the size of your thumbnails and the number of fields displayed in the
thumbnail view. The layout style, fonts and colors of the thumbnail view are applied. To control these
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settings, go to the Layout dialog in the Thumbnail view to adjust the appearance to your particular
needs.
A contact sheet can be further edited or printed using a third party image editing applications.  

QuickTime Movie Presentation
The Movie Presentation dialog allows you to save the slide show (full screen mode only), both with
generic and individual transition effects and timings, as a QuickTime Movie. A QuickTime Movie can
be played using Apple's QuickTime Player on both Mac and Windows computers.
iView MediaPro lets you enter the movie dimensions or choose from a predefined set of industry
standard sizes, as well as control the background color, default slide duration and transition effect. To
setup individual file transition effects and timing, set these up in the Setup Slide Show dialog.
Note that if you intend to playback your movie on a different platform, you will need enable movie
compression and choose the appropriate format.
Finally, iView MediaPro offers a range of playback options when running Apple's QuickTime Player,
for instance, click the QuickTime Player Options button and switch on auto-start and full screen mode
options to have your movie played back in full screen, automatically when you double-click on the
movie item.

File Conversions
The File Conversion dialogs are useful for single file or batch conversions. Simply select one or more
media items and choose the appropriate option to convert images, animations, or sounds.
Image conversion will convert images, as well as poster frames from animations into a new format
such as JPEG, TIFF, etc. Sound conversions will convert sound files as well as sound tracks from
selected movies.
For regular uses of this feature, you can save your options using the Options menu. Saved options can
be recalled at any time and can be incorporated in AppleScripts.
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Calibration And Version Control

The basic editing tools offered in iView MediaPro are: cropping, and mid-tone calibration tools that
can enhance colors, sharpness and brightness of your images. These tools generally serve the purposes
of the novice and average user. iView MediaPro does not attempt to offer more than these, as this
would be beyond the scope and general purpose of the application as a whole. In fact, iView MediaPro
has been conceived as a palette application, to use alongside editing applications, rather than to
replicate them.

Image Calibration

Cropping offers a convenient way to reduce the visible area of an image. After clicking the
cropping tool, the cursor changes to an arrow. You will need to select an area of your image and then
click anywhere within the selected area to accept the cropping.
Before accepting the cropping you may want to adjust the edges of the selection to fall exactly at the
desired location. Simply place the cursor over one of the for sides and drag to the desired place. Whilst
you adjusting the cropping area you can review the coordinates of the image in the calibration floating
window. You can click anywhere outside the selected area to cancel cropping.

Sharpness, Brightness & Contrast offers a convenient method to correct blurred images and
bring out fine details in images, but be careful not to over-sharpen as it will bring out imperfections,
making JPEG artifacts more visible.

The Hue, Saturation & Lightness tool lets you compensate for a lack of color definition in
images, but bear in mind that inkjet printers tend to over-saturate color, rendering the colors unrealistic.

Color Correction lets you adjust the colors of an image based on Cyan/Red, Magenta/Green, &
Yellow & Blue pairs. Whether you images have been scanned or imported directly from a digital
camera, either way, your images will need some color adjustment.

The Invert tool lets you invert the colors of images, and is particularly useful for inverting photo
negatives.

Note that Image Calibration applies to images only.
Image modifications by any of the tools described in this section, are not saved until you explicitly
press the save button in the floating window. You can discard all changes by pressing the revert button,
or by selecting another image in the catalog.
Saving a modified image presents you with three options: To overwrite the existing file simply press
save. To overwrite the file but make a backup of the original so that you can revert to it, make sure you
switch the Version Control option on. Finally you can simply create a new file that includes all your
modifications. The new file will automatically be appended in the catalog.
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Saving a file also presents you with options to change the format of the file, similar to those offered by
the Image conversion options.
Finally note that you can save an image at any time, not just after you applied some modification to it.
For instance you may want to rotate an image and save the rotated image without performing any
calibrations. It is important to note, however that saving image files removes any embedded
annotations that may exist in the original file.

Version Control
Version control is useful both for individuals and small work groups to browse and track through
different versions of the same files. This is particularly useful as a back up but also to revert to or
compare between different versions, and can be of great help during Image Calibration.
To setup Version Control, select a folder from the Version Control dialog in the Edit Menu. Backup
copies of version controlled files will be saved in this folder. You must make sure that you use a
separate folder for each catalog. The Version Control dialog also indicates the size of the folder and
maintains a log of the items added and removed from the folder, with the name of the original file and,
the number and details of each version saved. As the size of the folder grows, you may want to purge
the log to remove entries that have been removed from the catalog. The size of the folder will grow,
depending on the size and number of copies of files. It is therefore advisable to save the folder in a
directory which has plenty of storage space.
Once a version control folder has been assigned to the catalog, you can begin to back up media files.
To do this, select the image you wish to backup, and go to the version control section of the info panel.

Click on the plus sign to backup the file. The dialog which appears allows you to add a comment and a
signature. iView MediaPro automatically assigns the current time and date and, saves this data in the
export log in the version control folder, together with an encoded back up copy of the file. It is
important you provide a description of the reason you back up a file, as a reminded of the current status
of the image.
For example assume you may want to convert a photograph from color to black and white. You create
a backup and call it "my color version". Next you launch the file with an image editing application (or
with the calibrator), apply the changes and replace the current folder. When you look back at the
version control panel you notice that the versions are different.
You can examine and compare any backup version, at any time, by simply clicking on the different
versions in the list.
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There are three important icons next to backup versions:
The arrow icon replaces the current media file with the selected backed up version. This option will
also give you the opportunity to "Swap files" before replacing it.
The trash icon deletes the selected backed up version, and removes it from the Version Control panel.
The Comments icon allows you to edit the version comments and the name of the person who saved the
version at any time.
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Printing

Printing in iView MediaPro is essentially based on the layout settings predefined within each view (See
User Defined Views in Viewing Files in Your Catalog).

Each view has its own layout, fields, and characteristics, and there are different advantages in printing
in each mode. For example:

•  List or text table in Content View
•  Contact Sheet in Thumbnail View
•  One or more full size hi-resolution images in Media View

To customize your print out, go the "Layouts" dialog in Edit Menu, before choosing the print option, to
select: Fields, Color background, Font, Font color.

To define the image size, choose a size from the menu in the lower left corner of the active view, for
example:

•  Actual Size - the actual size of the image
•  Scaled to Fit - scales image to the size of the window.
•  Fit Smaller Side -draws the image with its smaller side expanded to fit the screen. This option

will fill the entire screen, but your image may be cropped.
•  Fit Larger Side - draws the image with its larger side expanded or shrunk to fit the screen.
•  Tiled To Screen - tile the image (in actual size) in the window. This option is particularly handy

when you are viewing patterns.

There are a number of Print Area Sizes, including full page, CDROM, Zip etc. You can define your
own print area size

•  Full Page, adjusts to the Page Size selected in the "Page Set Up" dialog, which differs
according to the Printer installed in the Pref..* As well as being compatible with the standard
printers, iView is also compatible with large format printer for posters and plotters.

 
Margins  settings adjust to the Print Area size. The mirror option creates spines for binding documents.
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Grid  is only visible in the Thumbnail and Media Views, and allows the user to select between:
•  Default Grid takes into account the predefined layout and image size settings selected within

each view mode, and the Print Area Size.
•  Custom Grid allows the user to define the number of rows and columns, but may over ride the

image size settings or possibly crop some of the field text if the Print Area Size is too small.
If you select Full Page in the Print dialog, you can adjust the Print Area Size by changing the
Page Size in the "Page Set Up" dialog. This dialog differs according to the Printer installed, but
this feature is useful for large format printing for posters and plotters.

In Media View, the Custom Grid has a limit of 4 rows by 4 columns, but has the advantage of full
image rendering and settings, for example, "Scale to Fit", "Actual Size", "Tile" etc. which can be set
from the pull-down menu in MediaView.

Captions: place headers, footers, right and left captions which are saved with the catalog and are
enabled when you select the icon next to each caption.

The "Special" drop-down menu allows you to place the Date (),Time (), No of Pages (), and Total
Number of Pages (), these are represented by their respective symbols in the caption's box. There is
also an "Indent" option which aligns the caption left, center or right.

Hints
Multilayer/Multipage Files - The program only prints the frame assigned as an item's preview. In order
to print a layer or page within a composite file, go to the page or layer you wish print and select
Rebuild Preview from the Action Menu before printing.

To print a selection: Use the find and show facilities to print a selection.

Current Image To print a single image, select one page from Range drop-down option in the "Print Set
Up" dialog. Otherwise this option prints from the current image to the end of the catalog.
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Quick Reference

The Tool Bar

Open with drop down menu lets you open one or more selected media items with its creator, or
any "Helper" application you include in the menu (option click will also launch an item with its
creator). Use the Helpers panel in the Preferences dialog to attach applications to this menu.

Show Original reveals the location of one or more selected media items in the Finder.

Trash removes one or more selected media items from the catalog and moves the original files
to the trash. iView MediaPro does not actually empties the trash. If you change your mind you
can always open the trash, select the moved files and press Command-Y (Put Away), to have
the Finder restore the files to their original folders.

Set Label sets or removes the label color for all selected items. To define the catalog’s label
colors and names choose Define Labels from the Edit menu. You can also use function keys F1
to F8 to label items, and F9 to remove labeling.

Voice Annotation allows you to record, listen or remove audio annotations attached in media
items. These are short, memo-like annotations, more frequently found in digital cameras or
other image capturing devices which incorporate this feature.
You can record your own annotation using your computer’s microphone, or embed a separate
sound file using the import option. You can later save the voice annotation as a separate sound
file using the "Extract Voice" in the Action Menu.

Move Cells options let you move selected media items anywhere within the catalog, in any
view mode:
Move to Top Moves the selected items to the top of the list.
Move to Bottom Moves the selected items to the bottom of the list.
Move to Location Moves the selected items to a specific position within the catalog, simply by
clicking at the desired location. To select a group of items, hold down the Shift or Command
key whilst selecting items.

Rotation sets the viewing angle of a media item (and its thumbnail) at 180º, 90º clockwise or
counter clockwise, as well as flip horizontally or vertically.
This is useful for images saved in landscape. Image rotation is saved with the catalog, and used
when during the export options. The rotation does not apply to the original image unless you
choose to save the image using the calibrator. To restore the viewing angle of the image select
Default View.

Playback contains options to play an animation, movie, sound, Karaoke file (same as space
key). This button becomes enabled only after you select a media item that can be played back.
The Repeat and Select options allow you to playback one or more items continuously in a loop,
which are fun features to use as background sound.
To stop an animation click on the Stop button, or click anywhere outside the group of animated
media files.
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Layout Options displays the Layout dialog for the current view.

Print  displays the Print Options dialog for the current view.

Run Slide Show starts up your presentation in slide show, at the selected media file. If no file is
selected the presentation start at the first file in the list.

Stop Search stops the current importing process ignoring all remaining items or cancels a
search in progress. Also command period.

Apple Menu
About - shows the credits and the version number of the program.
Media Importers - shows the complete list of media supported by iView MediaPro and your version
of the QuickTime media layer extension. Use the latest version of QuickTime to have the maximum
number of importers for different media types.
Language - lets you change the language of the application at any time, without having to re-launch
the application. By default, the application launches in the language of the operating system or saves
the last language setup.

File Menu
New - opens a new catalog.
Open - opens a saved catalog in a new window.
Open Recent - keeps a list of the last 10 catalogs used and allows opening them.
Save – saves a catalog.
Save As – saves a iView MediaPro catalog in a new file
Revert – discards all changes made to the current catalog.
Catalog Info – provides details about the catalog you are currently working with, such as location,
modification date, size, etc. This command will also let you lock and/or set a password for opening
your catalog. Locked catalogs cannot be saved. Catalogs with passwords cannot be opened unless the
correct password is typed in. Once a catalog is open you can clear its password by typing a blank
password string.
The Slide Show stand-alone feature allows you to run the catalog in the Finder as a stand-alone slide
show, hiding all other views and features.  To reset this option and to view or make changes to the
catalog, you will need to open it using the Open option in the File Menu.
Import Media - inserts a single media file or a single folder or volume.
NOTE: when importing a folder inside an existing catalog, iView MediaPro will only append unique
files to the list. Duplicates are automatically discarded.
Stop Import - stops the current importing process ignoring all remaining items.
Page Setup - lets you choose printer options
Print - lets you customize printable image reports/contact sheets for full size, zip, and CD jewel case
paper size. Note that iView MediaPro adjusts the contents of the Print Setup dialog depending on
which media view you wish to print (the currently active media view).
Printing in iView MediaPro is essentially based on the layout settings predefined within each view.
Each View has its own layout, fields, and characteristics, and there are different advantages in printing
in each mode. For example:
List or text table in Info View
Contact Sheet in Thumbnail View
One or more full size hi-resolution images in Media View
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To customize your print out, go the "Layouts" dialog in Edit Menu, before choosing the print option, to
select: Color background, Font, Font color, Image Size, Fields
There are also a selection of Print Area Sizes, including a default size, and 3 jewel case sizes.
Full Page, adjusts to the Page Size selected in the "Page Set Up" dialog, which differs according to the
Printer installed in the Pref..* As well as being compatible with the standard printers, iView is also
compatible with large format printer for posters and plotters.
Quit - quits iView MediaPro.

Edit Menu
Undo – works on add, select, move, mark, delete and sort commands.
Cut – On Cut (and Copy) commands iView MediaPro copies a reference to the selected items, so that
you can conveniently paste them into another catalog.
If only 1 item is selected, iView MediaPro will also put a copy of the media (image, text, movie,
sound) into the clipboard. This type can be pasted in any application that works with this type of file.
Note that you can pressing the Option key, while copying a single image iView MediaPro will let you
choose the preferred resolution for the clipboard picture.
Copy – See Cut.
Paste – If you paste a selection copied from a different catalog iView MediaPro appends the items at
the bottom of the current catalog.
If the clipboard contains data carried over from a different application, iView MediaPro will generate a
clipping file of the data and import it in the current catalog.
Clear – Removes all selected item from the catalog (same as hitting the delete key).
Select All – Selects all items of the front catalog.
Deselect – Deselects all items of the front catalog.
Invert Selection – Inverts the selection of the front catalog.
Layout - Add fields, define colors and fonts, adjust image size and layout to the current active view,
allowing each view mode (Contents, Thumbnail, Media and Slide Show) to be customized. Custom
layouts can be applied to all exports, including printing, web pages, slide shows and QuickTime movie
presentations.
You can also change the style of individual fields, from the pull-down menu which appears when you
select a field, as well as the amount of text space allocated to each field.
Define Fields | Add - allows the user to create user definable fields. The "Use favorites" options
automatically saves records into the favorites folder for quick editing in the Info Panel.
Define Fields | Remove - displays a list of all user fields in the catalog. To remove from the catalog,
simply select and click on the remove button.
Define Fields | Favorites Set - allows the user to define the current active favorite set. To create a
favorites folder, create a folder inside the Favorites folder in Plug-Ins. You can create any number of
folders, for example, classified under subject heading etc.
Favorite folders are individual folders with favorite files, each file representing a field within the
catalog. These files are created automatically when you add a new entry to a field. These files can be
edited, or replaced by existing lists, using any text editor.
Define Labels - allows the user to define label names and colors, either by a user defined criteria,
Finder Labels or industry standard IPTC urgency criteria, which can be saved as default in all new
catalogs.
Version Control - Set up version control to backup files and track different versions of the same file.
Simply choose or create a folder with plenty of memory.
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Drop Folder - Select a folder to store permanent image, text, movie or sound clips dropped from any
application that supports drag & drop, or from Internet browsers.
Enable "Folder Watching" to scan the selected folder for new media files while the catalog is open.
Import Options - Allows the user to define the criteria, filters and other importing options.
Preferences - Opens the preferences dialog (see section below).

Find Menu
Show All - reveals all files and is particularly important after quick searches and set operations which
display a subset of the entire catalog.
Show Omitted - reveals all hidden files while hiding the currently visible files.
Show Selected - reveals all selected files while hiding non-selected ones.
Show Duplicates - allows the user to find similar files. You can set the comparison criteria based on
image characteristics and filenames.
Find - opens the Find dialog and lets you select one or more media items inside your catalog by:
File attributes (name, size, creation date, etc.)
Media attributes (dimensions, duration, resolution, etc.)
Annotation attributes (keywords, categories, URL etc.)
Find Next - uses the last find criteria to select the next matching item. Use this command after a "Find"
command.
Find Missing Items - searches a catalog for broken links to media files and highlights all unmounted
or missing items, allowing you to either remove the selected items from the list or search for them in a
specified directory.
iView MediaPro keeps the path or address to the original file. Sometimes a file's name is changed or
the file/folder is moved then when you click to see a full size image you get "File Missing -43"
appearing in the top right corner. The thumbnail and other info is kept in the catalog but the path to the
full size image, movie, or sound is no longer correct (because the name was changed or the file/folder
was moved or the volume is not online).
Quick Sort - Lets you select a field to use for sorting your media from any view. You can also quick
sort your media by clicking on individual header tags in the "Contents" view.

Action Menu
Rebuild Preview - re-imports the selected file and rebuilds its thumbnail.
This command is also useful in movies that start up with a non-interesting frame. In these cases you
can play the animation (in media view), up until you find the frame you want to use as its preview. At
that point stop the movie and choose this command.
Depending on your preference settings iView MediaPro can rescan a thumbnail automatically if the
associated item has been updated. You can also use this command to update the thumbnails of all your
catalog files when you decide to change the thumbnail box size.
Synchronize | Import - This command allows you to import information (IPTC & QuickTime
Annotations, Voice recording, URL Address, Meta data) from the original files into the catalog re-
scanning the original files. This command is particularly useful when updating catalogs created with
earlier versions of iView multimedia.
Synchronize | Export - This command allows you to export data from the catalog into the original
files. The data can be packaged in one of 4 different formats, that largely depend on 3rd party software
you use with iView MediaPro. To find what format is appropriate for your application, please refer to
its manual.
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Annotations | Batch - allows you to select the field and either use the favorites list from the drop-down
menu next to the text box or enter directly the annotation text. Batch mode allows the user to modify
field or append to the list of keywords or categories, or replace the field according to some criteria.
Annotations | Clear - removes the annotation field from the selected media items. This option will let
you erase the entire annotation set or remove fields selectively.
Annotations | Extract Voice - saves voice recordings into sound files.
Rename - If a single file is selected, this command will activate its name field (same as clicking on the
file's name. When multiple files are selected, the command will open a "batch rename" dialog, to let
you specify the renaming options.
Move to Trash - Remove selected files from the catalog and moves the originals to the trash.
iView MediaPro does not actually empty the trash. If you change your mind you can always open the
trash, select the moved files and press Command-Y (Put Away), to have the Finder restore the files to
their original folders.
Move To Folder - Moves selected items to a new folder. iView MediaPro will always ask you to
confirm before replacing existing files. Note that if the files are moved to a folder in the same volume,
their reference in the catalog is updated.
Copy To Folder - makes a copy of all selected items to a new folder. iView MediaPro will always ask
you to confirm when replacing existing files.
Finder Properties | Lock – locks the original file preventing users from editing it.
Finder Properties | Unlock - unlocks the original file.
Finder Properties | Hide - makes original files invisible in the Finder.
Finder Properties | Show - makes original files visible in the Finder.
Finder Properties | Creator - allows the user to change the Creator signature of files. This is
particularly useful when you don’t own the application that created the file, but you can open it with a
different application that is mounted on your machine.
Finder Properties | Desktop Icons - will replace generic desktops icon with image icons of original
files for easy identification of files at a glance.
Finder Properties | Finder Comments - This command will save the caption field inside the comment
field, visible in the Finder and the "Get Info" window of original files.
Finder Properties | Media Thumbnails - This command will embed a small media thumbnail in
original files . Media editing applications use built-in thumbnails in the Open dialog for quick
identification.
Reset Sample Colors - can be used to reset the identifying sample color of one or more media items.
The color sample is particularly useful when searching for images of a specific color or tonality. A
Color Sample is automatically generated when the media is imported, but can be modified with this
command.
ColorSync Profiles | Embed – allows you to choose and embed a ColorSync profile to one or more
selected JPEG or TIFF media Items.
ColorSync Profiles | Remove – allows you to remove ColorSync profiles from one or more selected
JPEG or TIFF media items.
Assign URL - allows you to review or modify the URL of the original file. iView MediaPro
automatically assigns the URL of items dragged straight from Internet browsers.
Download Original - replaces the current file with a copy that can be downloaded from the original
URL.
Zoom In - enlarges the displayed image. This option is equivalent to Command+ and can be applied in
images displayed in Media View only.
Zoom Out - reduces the displayed image.
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Make Menu
Run Slide Show - Starts the slide show from the selected file. See "Presenting Your Images in Slide
Show"
Setup Slide Show - sets up slide show options, and can be called before running the slide show. Note
that all slide show options can be set while running the slide show.
HTML Gallery  - outputs a catalog as a HTML formatted web site. Photographers can use this option
to automatically create a web site of all their work. An HTML Gallery looks very much like a catalog
in iView MediaPro. It contains an index of thumbnails which when clicked inside your browser will
take you to a large view of the image. QuickTime movies can also be exported along with images.
Text Table - saves media property and annotation fields as a text file, which can used in any text
editor, database or spreadsheet application for further archiving of your media.
Contact Sheet - creates an image contact sheet of all thumbnails in a user definable size.
Movie Presentation - saves a catalog as a QuickTime movie which can be played via Apple's
MoviePlayer, without having to run iView MediaPro.
Convert Image Files - converts images and movie poster frames to different formats.
Convert Sound Files - converts movies to different formats.
Convert Movie Files - converts sounds to different formats.

Window Menu
Show/Hide Tabs - shows and hides tabs to give you a larger catalog viewing area.
Show/Hide Info Panel - shows and hides the info panel.
Display View – offers shortcuts to switch between the catalog views, particularly useful when the tabs
are hidden (Command 1, 2 and 3 to switch between views).
Show Catalog Index – displays the Index floating window allowing you to classify and view the
contents of the catalog according to a given field. Simply select the field and double click to display the
media files. Use "Show All" from the Find Menu to reveal to the full catalog contents.
Show Catalog Sets – displays the catalog sets floating window.
Show Calibrator - displays the calibrator floating window, useful in Media View only.

Apple Script Menu
This extra menu displays AppleScripts dropped inside the Plug-Ins:Scripts folder.

Preferences
General:
Show toolbar button tips: Displays a useful description under the toolbar buttons.
Sort using natural order -
Auto-Scan modified media items.
At startup: lets you select whether you want to open a new catalog, open last catalog or do nothing
every time you launch the application.
Double-Click: lets you select how iView MediaPro interprets double clicks. Note that Option double
click will always launch the selected item with the creator application.
Dimensions: Preference to change the default pixel dimensions to cm, inches, points, and picas.
Resolution: Preference to change the default resolution dimensions from Pixels/Inch to Pixels/cm.
Helpers:
This panel will let you choose your media editors so that you can quickly access them via the pull
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down menus in the application's tool bar. You can select any application from Adobe Photoshop™, to
Sound Edit™, to SimpleText and ResEdit.
Scratch:
The scratch folder keeps temporary versions of your open catalogs. Scratch files are erased when you
close or save your catalogs. Choose a fast local disk with large available space.
Images:
Display rendering for images larger than; Allows the user to place a limit on the size of images that the
application will display in media view and slide show mode. Instead iView MediaPro will display the
preview of the image. This option will accelerate importing large images when viewed in media view.
CMYK color conversion - enables or disables
RGB color conversion - enables or disables
Font:
Display character set: shows the lower part of the ASCII character set, used primarily in Latin and
English-speaking countries.
Display extended character set: displays the entire character set.
Display sample text: lets you type a phrase and compare it using your cataloged fonts.
Font size (Media View): used for the media view font display. Adjust to nearest available size in order
to obtain a smooth representation of non-true-type fonts. This option can be switch off if you are using
ATM™ font manager control panel.
Font size (Thumbnail View): used to render font thumbnails. iView MediaPro makes font thumbnails
using the name of the font.
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